Bronze Belt Ninja Guide

Activity 01: Dropping Bombs




WELCOME TO BRONZE BELT!

Welcome to Bronze Belt! You've reached a significant milestone in your journey. It's
a great accomplishment, and you should be proud of yourself. Everything that you've
learned up to this point has been in preparation for this.

From now on, you'll be working with the same tools that professionals use to make
games. This might seem a bit overwhelming at first. There are so many different
options and ways to do things that it might make your head spin at first. Don't forget
what you learned before in the previous belts. At the heart of every lesson are the
same core programming concepts. You're still using variables, conditionals, and
functions. The difference with Unity is that you have so many more opportunities
than you had before.

But before we begin, what is Unity?
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WORKING IN UNITY

Unity is the same tool used by professionals to make games such as Pokémon Go,
Fall Guys, and Among Us. With Unity, you can bring various elements together to
build a complete game that can be played on different devices and platforms.

SIMONG: VS

Image Sources (Left to Right): 1) Among Us: Epic Games, 2) Fall Guys: Fall Guys | Download & Play Fall
Guys on PC for Free - Epic Games Store, 3) Pokemon GO: Pokémon GO (pokemongolive.com)
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https://www.epicgames.com/id/login?lang=en-US&noHostRedirect=true&redirectUrl=https%3A%2F%2Fstore.epicgames.com%2Fen-US%2Fp%2Famong-us&client_id=875a3b57d3a640a6b7f9b4e883463ab4&prompt=pass_through
https://store.epicgames.com/en-US/p/fall-guys
https://store.epicgames.com/en-US/p/fall-guys
https://pokemongolive.com/

WHAT DO | NEED TO KNOW?

To get you started, we will concentrate on the Unity interface, how to find things and
what to do with them. For the first few activities, you will use pre-built scripts to make
your games. This approach will ease you into Unity's environment until you are
familiar enough with Unity to start working with the programming language, “C Sharp”
(C#).

Unity utilizes C# because it seamlessly aligns with the components of Unity game
objects. Furthermore, as you'll soon discover, you can attach multiple C# scripts to a
single object, facilitating the writing of code in manageable, bite-sized portions.

A BRIEF WORD ABouT 2D AND 3D

Games are typically developed in either a 2-dimensional (2D) or 3-dimensional (3D)
environment.

In a 2D environment, your focus lies in the x and y axes, governing an object's
horizontal and vertical movement. The x-axis represents left and right movement,
while the y-axis represents up and down movement. However, it's worth noting that
the z-axis can also be employed in 2D to position or layer objects in depth, albeit
without the perception of 3D space.

On the other hand, 3D introduces an additional dimension, the z-axis, which allows
for forward and backward movement. Unity provides the flexibility to create games
in either a 2D or 3D environment, even though Unity's core architecture remains 3D.
You can initiate a Unity project in 3D and utilize a 2D (orthographic) camera and 2D
colliders to craft a 2D game using 3D objects, as we'll demonstrate later in this section.

While all the activities in this book start as 3D projects, the initial ones exclusively
involve the x and y axes, helping you understand that objects in Unity can take on
various dimensions as needed!
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GETTING STARTED WITH UNITY

1 To start, locate Unity Hub on your desktop. The icon should resemble something like the
image below. Move your cursor to Unity Hub and click it twice to open the app.

If you can’t locate Unity Hub on your desktop, let a Code Sensei know and they will assist

o

youl!

Unity Hub

2 Once you click Unity Hub it will appear, and you will be greeted by a screen that looks like
this. Please note, the screen appearance may differ as Unity has a Black and White
appearance option.

@

Welcome to Unity Hub

M. Il your Unity and
ed allations in o

Sign in

The Heretic
Made with Unity
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3 If you already have a Unity account then you can select the “Sign in” button otherwise

click on “Create account”. Remember, if you are under the age of 13, you will need to get

permission to create a Unity account. If you're having trouble, have your Code Sensei

help you.

When you click on the create account button, you will see a screen like the one below:

g Unity ID

Create a Unity ID

If you already have a Unity ID, please sign in here.

Email Password

Username

Full Name

| have read and agree to the Unity 15 of Ser (required)

| acknowledge the Unity Privacy Policy [Republic of Korea Residents fm not a robot
agree to the Unity Collection and Use of Pers formation]
(required)

| agree to have Marketing Activities directed to me by and receive
marketing and promotional information from Unity, including via email

and social media(optional)

s oA

fe

reCAPTCHA
.............

You can fill in your details or have a Code Sensei help you do this. You can also sign on
using a single sign-on provider, such as Google or Apple. Once you finish your details,
click Create a Unity ID. Then return to Unity Hub.

Once your account is created, sign into Unity Hub with it.
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4 Once you are signed in, you will see the Projects window.

When you first start, you will not have any projects to open. That's okay. Make a new one
by clicking the blue “New project” button.

Projects Add  ~ | New project

CLOUD MODIFIED EDITOR VERSION

No projects, yet.

5 On the left side of the screen are options for what type of project you will be creating.
You will most often be choosing 2D or 3D. Go ahead and leave 3D selected.

New project
Editor Version: 2022.3.19f1 L1s

2D (URP)
Core

3D Mobile
Core

2D Mobile
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6 Ensure that the Editor Version at the top of the screen states “2022.3 LTS"

New project

Editor Version: 2022.319f1 urs

Using this version will ensure everything looks the same as you follow along in this
guide.

7 You will also need to select a name for your project. This is very important: you cannot
change the name of a project once it is created. Make sure that it describes the project
well.

Your first project is Dropping Bombs, so select a name that reflects that. For example, if
your name is John Ninja, why not use your initials and name your file JNDroppingBombs.

act that uses Unity's

Read more

Project name

JMDroppingBombs
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8 Finally, you need to choose where to store your Unity projects. It is best to create a new
folder with a name like John Ninja's Unity or JNUnity to keep everything in one place.

However, your Code Ninjas location may handle Unity project storage differently. Ask
your Code Sensei where to save your Unity projects before proceeding to the next step!

9 All that's left to do is click on CREATE and let Unity set up the files for your first project!
Once that's done, move to the next page to create your first game in Unity!

Pro Tip:

Projects in Unity are saved in the location that you've chosen as a folder with the name of

! =
your project. If you ever need to duplicate a project, just make a copy of the folder and all
its contents and paste it and give it a new name. To open the new folder in Unity, click on
Add and select the new folder.
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ACTIVITY 1: DROPPING BOMBS

This first project in Unity is meant to show you the possibilities achievable even
without elaborate graphics, animations, or complex scripts. If you haven’t done so
already, open Unity and create a new 3D project, and give it a name like
MylnitalsDroppingBombs.

1 After you have created your new project, Unity will open and show you something like
the image below. Don't worry if it doesn’t look exactly like this, we'll take care of that in
the next step.
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2 Unity gives you the option to rearrange the layout based on what works best for you. But
for now, let's make sure you are using the default layout to avoid confusion. Click the
Layout button located in the upper right corner. Select Default and your window should
look just like the above image.

2by3

4 Si lit

Tall
Wide

Save Layout...

Save Layout to File...

Load Layout from File...

Delete Layout >
Reset All Layouts

If you decide to rearrange the layout, you can use this same
m‘ menu to save it for the next time you need it by clicking the

"Save Layout..." button.

3 Even though this is a 3D Unity project, our game is only going to use movement in 2
dimensions (left to right, up and down). With that in mind, we can change the view so
that it is strictly 2D. To do this, click the 2D button above the scene window as shown
below.
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4 On the left side of the display is the Hierarchy panel. This shows you all of the

GameObjects that are inside your scene. By default, Unity creates a Sample Scene and
sets up a camera and light for you. Select the Main Camera. To the right of the scene,
there is a panel called the Inspector. This panel contains all of the components associated
with the selected GameObject in the Hierarchy. In this case, we want to change the
Projection property of the camera from Perspective to Orthographic as shown below.
We're doing this so that when we play the game, the objects will maintain their
proportions and not get distorted by a 3D camera.

= Hierarchy 8 : |[einspector =) -

:
+v or @ @ ¥ Main Camera Static

-
Tag MainCamera Layer Default >

A SamnleScene
0 Main Camera A Transform

) pirectional Ligrht

Position
Rotation
Scale

@( v Camera

Clear Flags
Background
Culling Mask
Projection
FOV Axis
Field of View

Physical Camera

Clipping Planes

Viewport Rect

Depth

Rendering Path
Target Texture
Occlusion Culling
HDR

MSAA

Skybox

Everything

v Perspective

Orthographic

Near 0.3

Far 1000

X 0 Y O
W1 Hil 1

-1
Use Graphics Settings

None (Render Texture)
v

Use Graphics Settings
Use Graphics Settings

Allow Dynamic Resol
Target Display Display 1

{3 v Audio Listener

Add Component
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5

File

ec

= Hierarc

+~

Edit GameObject Component

- Create

Show in Explorer
Open

b d

¢ Delete
) Rename

Copy Path
Open Scene Additive
View in Package Manager

Import New Asset...

Services

To make things easier, Code Ninjas has created some special scripts to use in this game.
To load them, click Assets and select Import Package followed by Custom Package.

Jobs Window Help

Alt+Ctrl+C

Import Package

> I Custom Package... ‘

Export Package...
Find References In Scene

Select Dependencies

Refresh
Reimport

Reimport All
Extract From Prefab
Update UXML Schema

Generate Lighting
Open C# Project

I Project

+ -

% Favol

View in Import Activity Window

Properties...

Ctrl+R

Ctrl+Shift+L

Alt+P

6

Name ~ Date modified

1@ BaseScripts.unitypackage 2/13
@ BombDropAssets.unitypackage 2/13
@ CodeNinjasAvatar.unitypackage 13
@ CoinCollectible.unitypackage n
@ DontTouchTheCubes-StarterPack.unitypa... 2
@ Flame.unitypackage 2
@ glowEffect.unitypackage 2
@ MeanyBird-StarterPack.unitypackage 2/13
@ MyDroppingBombs1.unitypackage 2/13
@ MyDroppingBombsPart2.unitypackage
@ MyDroppingBombsPart3.unitypackage
9 Unity i

@ ParticleLeaves.unitypackage

@ PolyBeats-UnityPackage.unitypackage 2/13,
@ PolyRun-StarterPack.unitypackage
G2 RedRnrket initunarkans

Navigate to the folder where your resource files are (ask your Code Sensei if you are
uncertain) and select Activity 01 - DroppingBombsAssets.unitypackage.

Unity package file
Unity package file 35KB
Unity package file 576 KB

age file

v

1ame: | BombDropAssets.unitypackage

v | unitypackage (“.unitypackage) -

Cancel

@ CODENINJAS'




7 Unity will show you an import window with a list of the assets in the package. This gives
you the option of loading just some of the assets instead of all of them. In this case, we
want them all, so click All and then click Import.

Import Unity Package u
BombDropAssets
All

v
v

AR

<

v Bs
v A
v A
v 8

Cancel Import

8 The assets that you just loaded have been placed in the Project panel at the bottom of
the Unity editor. The Project panel shows you everything that is a part of your project in
folders, just as if you were browsing through files on your computer. In fact, these
folders have been created as part of your project. Notice that you now have a new

Resources folder and a Scripts folder that were imported with your package. You'll be
using the scripts later.

In Unity, the Scene, Hierarchy, Inspector, and Project panels are
{ I where you'll be doing most of your work, so feel free to take a

few moments to look around each of these panels and become

familiar with their functionalities.
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9 At the moment, the scene is a bit empty. Let's add a GameObject to the scene. Click the
GameObject menu, select 3D Object and Cube to add a cube to the scene.

GameOb'ectIComponent Services Window Help

Create Empty Ctrl+Shift+N
Create Empty Child Alt+Shift+N
Create Empty Parent Ctrl+Shift+G
3D Object > | Cube
Effects > Sphere
Light > Capsule
Audio > Cylinder
Video > Plane
ul > Quad
el 7 Text - TextMeshPro
Camera

Legacy >
Visual Scripting Scene Variables

Ragdoll...
Center On Children

Terrain
Make Parent Tt
Clear Parent Wind Zone
Set as first sibling Ctrl+=
Set as last sibling Ctrl+-
Move To View Ctrl+Alt+F
Align With View Ctrl+Shift+F
Align View to Selected
Toggle Active State Alt+Shift+A

1 0 You should now see a cube added in the Hierarchy panel. Select the cube (if it isn't
selected already) to see the components for the cube in the Inspector panel.

= Hierarchy
+ v Qr
R SampleScene*

2 Main Camera
A Directional Light

Ea Cube
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1 1 If you want to reposition, rotate, or make other changes to a GameObject within a scene,
select the object in the scene by clicking on it and then using the tools above the scene

to manipulate it. Go ahead and give it a try with the cube.

Move Tool: To
move the
selected object
in a single plane.

Scale Tool: To
manipulate the
scale of a single

axis.

Transform Tool:
Move, Rotate and
Scale your

GameQbijegcts in the
Scene.

Hand Tool:
Used to move
around the
scene.

Rotate Tool: To
turn the selected
object around its

pivot point.
Rect Tool: Used
adjusting the
scaling of an
object, either
entirely or partially.

Pro Tip:

Regardless of the tool you're utilizing, navigating within the

scene panel is easy using the mouse. Simply use the mouse

wheel to zoom in or out of the scene. Furthermore, holding
down the right mouse button and dragging allows you to move

to the specific area of the scene you wish to interact with.
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1 2 After you are done with the cube in the scene, it's best to return it to the middle of the
scene at 0, 0, 0. With the cube selected, find the Transform component at the near top
of the Inspector panel. This component shows the current position, rotation, and scale of
the GameObject. A quick way to reset the transformations is to click on the three-dot
menu in the upper right corner of the Transform component and then click on Reset.
This should restore the cube’s default settings.

© Inspector

[Ij v Cube
Tag Untagged v Layer Default

Transform

Move to Front

Move to Back

Find References In Scene

Properties...
B8 v MeshRend
Co >
Materials Py
Lighting Paste 2
Cast Shadows Reset Property ?
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1 3 Now to add another GameObject to the scene. You can follow the same procedure as in
the previous steps, but here's an alternative approach. In the Hierarchy panel, click the
Plus button in the upper left corner and then click 3D Object. Finally, select Sphere so we
won't confuse it with the cube.

# Scene o Game
[F]center» PLocal »

= Hierarchy

+ -

Create Empty
Create Empty Child
Create Empty Parent
| 3D Object > Cube
Effects > I Sphere I
Light > Capsule
Audio > Cylinder
Video > Plane
ul > Quad
Sl i’ Text - TextMeshPro
Camera Peneey >
Visual Scripting Scene Variables
Move ToView Ragdoll...
Align With View Terrain
Align View to Selected Tree
Teggle Active State Wind Zone

1 4 Let's make sure that the sphere starts out in the same spot as the cube. Use reset if
necessary.

© Inspector
v Sphere

Tag Untagged Layer Default

Transform

Move to Front

Move to Back
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1 5 We want the sphere to start out above the cube. You can either use the move tool to
move it in the scene or change the Y position of the sphere from 0 to 5 in the Transform
component in the Inspector panel.

@ v Sphere

- Tag Untagged

A Transform

Position
Rotation

Scale

1 6 This game is called Dropping Bombs, not Dropping Spheres! Change the name of the
sphere to Bomb by highlighting the name in the Inspector panel and typing in the new
name.

@ v  Bomb Static ¥

h 4

Tag Untagged v Layer Default v
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1 7 If you started the game now, not much would happen. Both game objects are just floating
in space. If you want the bomb to drop, you'll need to have it respond to gravity. To do
that, you'll need to add a new component to the object. With the bomb selected in the
hierarchy, scroll to the bottom of the Inspector panel and click Add Component. This
opens a menu of all sorts of new components and behaviors that can be added to the
game objects. The component that you'll need is in Physics, so select that section.

Component
Layout
Mesh
Miscellaneous
Navigation
Physics 2D
Physics
Playables
Rendering

Scripts

Tilemap
Ul Toolkit
0]

Video

Pro Tip:

lm‘ There are two choices for Physics in the Add Component menu.
Physics 2D responds a bit differently than Physics. Therefore,
make sure that you choose Physics for this activity!
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1 8 A submenu of Physics related components should open. These components are useful
for many different sorts of behaviors. The one we want is called Rigidbody. The
Rigidbody component allows the GameObject to behave like any average object in the
real world. Select it to add this component to the bomb object.

a

Physics

B

'8 Character Controller
® Character Joint

W Cloth
=& Configurable Joint
s Constant Force

Q)Fixed Joint

fl§ Hinge Joint

HH Mesh Collider
&5 Rigidbody

@ Sphere Collider
% Spring Joint

@ Terrain Collider
@ Wheel Collider

1 9 The Rigidbody component has many parameters that can be adjusted to get the
GameObiject to respond to forces inside the game. Right now, we just want to have it
respond to gravity, so make sure that Use Gravity is checked.

& Rigidbody

Mass 1
Drag 0]
Angular Drag 0.05
Automatic Center Of | v
Automatic Tensor v
Use Gravity v

Is Kinematic

Interpolate None
Collision Detection  Discrete
Constraints

Layer Overrides
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20 Test the game by clicking the Play arrow above the Scene panel. The Bomb should fall
until it touches the cube and then it stops. When a 3D object like a cube or a sphere is
added, a special component called a Collider is added with it. Without the Collider, the

object wouldn’t even know the other object is there and move right through it!

Stop the game by clicking the Play arrow a second time.

21 The objective of this game is to avoid falling bombs by moving the cube. To move the
cube, we'll need a special set of instructions called a script. You loaded some scripts
when you imported the unity package. To see them, click on the Assets folder in the
Project panel then click Scripts to open the folder.

Scripts

m Unity Ul
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22 Attach the Movement script to the cube by simply dragging it into the Cube object in the
Hierarchy panel.
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23 Make sure the cube is selected in the hierarchy panel. You will find the Movement script
is now part of the components attached to the cube in the Inspector panel on the right.
By default, the script has a movement speed of 0, meaning the cube won't move at all.
Let's try a movement speed of 10. Leave the other parameters unchanged.

© Inspector 2 =

@ v Cube Static ¥
v

Tag Untagged v lLayer Default 8.4

A Transform

Position X 0
Rotation X 0
Scale ® X1

B  cube (Mesh Filter)
Mesh B8 Cube

HJ v Mesh Renderer

Materials

Lighting
Cast Shadows On
Receive Shadows v
Contribute Global |

Probes
Light Probes Blend Probes
Reflection Probes Blend Probes
Anchor Override  None (Transform)
Additional Settings
Motion Vectors Per Object Motion
Dynamic Occlusiol v

B} v Movement (Script)

Movement
Speed 10
Movement |ype All Directions

Platform Movement
Platform Settings
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Play the game. Use the arrow keys or the WASD keys to move the cube around. Stop the
game by clicking the Play arrow a second time.

PROJECT SETTINGS

Every project in Unity has a variety of settings that can be configured for whatever
situation that you need them for. One of these settings is Input, controlling how the
user interacts with the project. Every new project starts out with default settings for

input with room for more if needed.

Our provided movement script takes advantage of those settings so that the game can
accept input from the arrow keys as well as WASD keys and even a gamepad if one is
available!

£ Project Settings

Adaptive Performance |nput Manager

Mouse ScrollWheel
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25 To make things more interesting, let's have something happen if the bomb touches the
cube. We have a script called Reset that will start the game over again if anything
collides with the GameObject the script is attached to. We want to attach this script to
the bomb. Instead of dragging the script over like we did with the movement script,
here's another way. Select the bomb in the Hierarchy and in the Inspector panel, click
Add Component and select Scripts.

Component

Miscellaneous

Navigation
Physics 2D
Physics

Playables
Rendering
Scripts

Tilemap

Ul Toolkit

Ul

Video

Visual Scripting

New script

26 The menu will change to show the available scripts. Click Reset to add the reset script to
the bomb.

Scripts
E® Boundaries

&4 Movement
Reset
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27 Of course, if the bomb doesn’t touch the cube, it will just keep falling. We have a script
to fix that, too. The Teleport script checks to see if the attached GameObject has gone
below the bottom edge of the screen and if so, places that same object at the top of the
screen to let it fall again from a new position. Add the Teleport script to the bomb either
by dragging it over or by using Add Component.

= Hierarchy
S

) SampleScene*

ra

ssets > Scripts
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28 To make things more interesting, let's add a few more bombs. Select the bomb in the
Hierarchy panel and press Ctrl+D (Windows) to make a copy. Start with a few, test it,
and then add some more until it feels right to you.

Once you have added some more bombs select your Cube in the Hierarchy. In the
inspector panel select the Tag dropdown menu. In this menu select Player.

= Hierarchy
+ v o
P SampleScene*

2 Main Camera
@ Directional Light

@ Cube
@ Bomb
& Bomb (
) Bomb (
2 Bomb (
) Bomb (4

1)
2)
3)
)

Pro Tip:

m‘ Remember, if you make changes to one of the bombs, you'll need to make
changes to the rest of them or delete the other bombs and copy the new one.
This isn't very efficient, is it? You'll learn a better way later.

29 Start the game. Use the arrow keys or the WASD keys to avoid the bombs. If the bomb
hits the cube, the game resets to the original start settings. The Teleport script is now
placing the bomb in random positions on the screen.

Stop the game by clicking on the Play arrow a second time.
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30 Now when you start the game, many bombs come from different positions to attack
your cube!

31 But there's one last thing to add to the game. At the moment, the cube can avoid all the
bombs by leaving the screen! The Boundaries script keeps the cube inside the screen.
Add the script to the cube to keep it in place using either option learned in this activity.

You just made your first game in Unity! Way to go! Later, you'll add some graphics
and effects to make it look better, but the best games are fun even before all the
graphics are added.
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ADJUSTING THE CUBE

STARTING POSITION

Do you have enough time to dodge the bombs when the game starts? You can move
the cube lower in the screen by changing the Y value for the Transform position.

O Inspector

@ v Cube Static =

v

Tag Untagged Layer Default

- Transform

Position

MOVEMENT SPEED

Is the cube not moving fast enough? Increase the number for the movement speed
to make dodging easier. Just don’t make it so fast that you can’t control the cube!

v Movement (Script)

Movement
Speed
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ADJUSTING THE BOMB

SIZE

Would a smaller target be easier to dodge? Change the scale in the X, Y and Z
parameters to a fraction of 1 to make the bomb smaller.

© Inspector =

@ v Bomb (4) Static ~

Tag Untagged v Layer Default v

- Transform
Position
Rotation

Scale

DRAG

Change the Rigidbody settings of the sphere so that there's a bit of drag to slow it
down when falling. Start with small numbers and work your way up.

&  Rigidbody

Mass

Drag

Anqgular Drag

Don’t Forget! When you change the parameters of one bomb it won't change any of
the other! Either apply the same changes to all the bombs or delete the unchanged
bombs and make copies of the changed one.
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SAVING AND SUBMITTING YOUR GAMES

1 When you save a game in Unity, that project is saved on a folder in your computer for
you to open with Unity and resume work on it. However, we need to get it to your Code
Sensei so they can grade your game!

2 In the Project folder, click on the Assets folder. We do this so that Unity knows we are
about to export all the assets and different components that make up your game.

B Project B Console
-+ v
W ravornes
O, All Materials
O, All Models

O, All Prefabs

(@ Assets
BB Kesources

3 We are going to export your game and it will create something called a Unity Package.
First, click on the Asset button in the top left corner then navigate to Export Package.

File Edit J Assets ] GameObject Component Services Window
Create >
Show in Explorer

Open

Delete

Rename

Copy Path Alt+Ctrl+C
Open Scene Additive
View in Package Manager

Import New Asset...

Import Package >
I Export Package... I
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4 Once Export Package is selected, the Items to Export Menu will appear. Ensure all your

game components are checked and the Include dependencies checkbox is clicked before
clicking on Export at the bottom-right.

Items to Export

All None

v BB Resources
v BB Icons
v -l yundaries.png
v .I‘ ovement.png
v mre'-_irf' pNg

teleport.png

ge gepenaenciles
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Once Export is selected, a window will appear asking you where you want to save your
game and what you want to name it. This is called a File Explorer window. Use a file name
that clearly describes your game, such as the Project's name, and put it into a folder that
you can find easily.

In this example, we've put it into a folder named "JWUnityGames" and named the file
"JWDroppingBombs1". Your names should include your initials to be a bit more specific!

» ThisPC = HDD(D:) » jonah * JWUnityGames

File name: | JWDroppingBombs1 -

Save as type: | unitypackage (*.unitypackage) ~

# Hide Folders Save Cancel

It may take a minute for the export to finish so just wait until it is complete. Once it is
complete you can move onto the next step!
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6 In the IMPACT portal, click the Upload File button. In the File Exporer window, select
the .unitypackage file you just made!

r ) |

Scavenger Hunt D
Current Uploaded File:

BB Activity 02 - Sensei Example Project v26....

2, UPLOAD DIFFERENT FILE m

b v

Once the file has been uploaded, close the window. Click the Submit for Review button to

Once you do this, your game is now submitted and ready for grading! You will submit
each of your activities like this, so just navigate back to this page if you ever forget how.

Submit Project

‘ . BB Activity 01 - Sensei Example ... ‘

‘ SUBMIT FOR REVIEW ‘
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